CC3200 SimpleLink™ Wi-Fi® and IoT Solution with MCU LaunchPad Hardware

User's Guide
List of Figures

1. CC3200 LaunchPad EVM Overview ................................................................. 5
2. CC3200 Block Diagram ................................................................................ 6
3. Pn-1 Marking on the LaunchPad (white triangle) ...................................... 7
4. JTAG Headers .............................................................................................. 7
5. I2C Connections .......................................................................................... 8
6. UART Signals ............................................................................................... 10
7. SOP Jumpers ............................................................................................... 11
8. 2x20 Pin Connector ..................................................................................... 15
9. Powering From USB ................................................................................... 16
10. Battery Power .............................................................................................. 17
11. Measuring Low Power ............................................................................. 18
12. Measuring Active Power ......................................................................... 19
13. Radiated Testing Using Chip Antenna ....................................................... 20
14. Board Set for Conducted Testing ............................................................... 20

List of Tables

1. JTAG Headers .............................................................................................. 8
2. Jumper Settings ........................................................................................... 8
3. Default I2C Addresses .............................................................................. 9
4. Jumper Settings ........................................................................................... 9
5. UART Signals ............................................................................................ 10
6. SOP Lines .................................................................................................. 11
7. Miscellaneous Settings ............................................................................. 12
8. Push Buttons ............................................................................................. 13
9. LEDs ......................................................................................................... 14
10. Change Log ............................................................................................... 21
1 Introduction

1.1 CC3200 LaunchPad

The high performance CC3200 is the industry's first single-chip Microcontroller (MCU) with built-in Wi-Fi connectivity for the LaunchPad™ ecosystem. Created for the Internet of Things (IoT), the SimpleLink Wi-Fi CC3200 device is a wireless MCU that integrates a high-performance ARM® Cortex®-M4 MCU allowing customers to develop an entire application with a single IC. With on-chip Wi-Fi, internet and robust security protocols, no prior Wi-Fi experience is needed for faster development.

The CC3200 LaunchPad is a low-cost evaluation platform for ARM® Cortex™-M4F-based microcontrollers. The LaunchPad design highlights the CC3200 Internet-on-a-chip™ solution and WiFi capabilities. The CC3200 LaunchPad also features programmable user buttons, RGB LED for custom applications and onboard emulation for debugging. The stackable headers of the CC3200 LaunchPad XL interface demonstrate how easy it is to expand the functionality of the LaunchPad when interfacing with other peripherals on many existing BoosterPack add-on boards such as graphical displays, audio codec, antenna selection, environmental sensing, and much more. Figure 1 shows a photo of the CC3200 LaunchPad.

Free software development tools are also available, including TI's Eclipse-based Code Composer Studio™ and IAR Embedded Workbench®. More information about the LaunchPad, the supported Booster Packs, and the available resources can be found at TI's LaunchPad portal. Also visit the CC3200 Wiki page for design resources and example projects.

---

**NOTE:** The antennas used for this transmitter must be installed to provide a separation distance of at least 20 cm from all persons and must not be co-located or operating in conjunction with any other antenna or transmitter.

**NOTE:** All figures and references in this document apply to the Rev3.2. Most of the document also applies to the Rev4.1, unless otherwise stated. For the exact list of changes made across board revisions, refer to Section 2.8.2.

1.2 Key Features

- CC3200, SimpleLink Wi-Fi, internet-on-a-chip™ solution with integrated MCU
- 40-pin LaunchPad standard that leverages the BoosterPack ecosystem
- FTDI based JTAG emulation with serial port for Flash programming
- Two buttons and three LEDs for user interaction
- Backchannel universal asynchronous receiver/transmitter (UART) through USB to PC
- On-board chip antenna with U.FL for conducted testing

SimpleLink, LaunchPad, Code Composer Studio are trademarks of Texas Instruments.
ARM® Cortex is a trademark of ARM Limited.
ARM, Cortex are registered trademarks of ARM Limited.
IAR Embedded Workbench is a registered trademark of IAR Systems AB.
Wi-Fi is a registered trademark of Wi-Fi Alliance.
All other trademarks are the property of their respective owners.
Introduction

- On-board accelerometer and temperature sensor for out-of-box demo
- Micro USB connector for power and debug connections

1.3 What's Included

Kit Contents

- CC3200 LaunchPad development tool
- Micro USB cable
- Quick start guide

1.4 FCC/IC Regulatory Compliance

The CC3200 SimpleLink Wi-Fi and IoT solution with MCU LaunchPad hardware is FCC Part 15 and IC ICES-003 Class A compliant.

2 Hardware Description

![Figure 1. CC3200 LaunchPad EVM Overview](image)
2.1 Block Diagram

![CC3200 Block Diagram](image)

**Figure 2. CC3200 Block Diagram**

2.2 Hardware Features

- CC3200, SimpleLink Wi-Fi, internet-on-a-chip solution with integrated MCU40-pin LaunchPad standard that leverages the BoosterPack ecosystem
- FTDI-based JTAG emulation with serial port for Flash programming
- Supports both 4-wire JTAG and 2-wire SWD
- Two buttons and three LEDs for user interaction
- Virtual COM port UART through USB on PC
- On-board chip antenna with U.FL for conducted testing
- On-board accelerometer and temperature sensor for out-of-box demo with option to isolate them from the inter-integrated circuit (I2C) bus
- Micro USB connector for power and debug connections
- Headers for current measurement and external JTAG connection
- Bus-powered device with no external power required for Wi-Fi
- Long range transmission with highly optimized antenna (200m typical in open air with a 6dBi antenna AP)
- Can be powered externally, with 2xAA or 2xAAA alkaline batteries working down to 2.3V typical (typ)
2.3 Connecting a BoosterPack

A compatible BoosterPack can be stacked on top of the LaunchPad using the 2x20 pin connectors. Note that the connectors do not have a “key” to prevent the misalignment of the pins or reverse connection. Ensure that Vcc and 5V pins, are aligned with the BoosterPack header pins. On the CC3200 LaunchPad, a small white triangle symbol is provided near Pin-1 (see Figure 3) to orient all BoosterPacks. This same marking, provided on compatible BoosterPacks, needs to be aligned before powering up the boards.

![Figure 3. Pn-1 Marking on the LaunchPad (white triangle)](image)

2.4 Jumpers, switches and LEDs

2.4.1 JTAG Headers

The headers are provided on the board to isolate the CC3200 device from the mounted FTDI JTAG emulator. These jumpers are shorted by default when the board is shipped from TI. To connect an external emulator, remove these jumpers and place the external emulator on the pins closer to the CC3200 device.

![Figure 4. JTAG Headers](image)
Table 1. JTAG Headers

<table>
<thead>
<tr>
<th>Reference</th>
<th>Usage</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>J8 (TCK)</td>
<td>JTAG</td>
<td>Short : Routes the on-board emulator to the CC3200</td>
</tr>
<tr>
<td>J9 (TMS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>J10 (TDI)</td>
<td></td>
<td>Open: Isolate the on-board emulator from the CC3200.</td>
</tr>
<tr>
<td>J11(TDO)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(1) For the SWD mode, only TCK and TMS need to be shorted to the CC3200.

When a battery is used, be sure to disconnect all the JTAG headers to prevent any reverse leakage current.

2.4.2 I2C Connections

The board features an accelerometer and a temperature sensor for the out-of-box demo. These are connected to the I2C bus and can be isolated using the jumpers provided.

![Figure 5. I2C Connections](image)

By removing J2 and J3, the accelerometer and the temperature sensors are isolated from the I2C bus. Note that this also removes any pull-up resistor from the I2C bus.

2.4.2.1 Jumper Settings

Table 2. Jumper Settings

<table>
<thead>
<tr>
<th>Reference</th>
<th>Usage</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>J2</td>
<td>I2C SDA</td>
<td>Short : Connect the CC3200 I2C bus to the on-board sensors with pull-up Open : Isolate the sensors from the CC3200</td>
</tr>
<tr>
<td>J3</td>
<td>I2C SCL</td>
<td>Short : Connect the CC3200 I2C bus to the on-board sensors with pull-up Open : Isolate the sensors from the CC320</td>
</tr>
<tr>
<td>J4</td>
<td>INT</td>
<td>Short : Connect the accelerometer interrupt to the CC3200 on GPIO13</td>
</tr>
</tbody>
</table>
2.4.2.2 Default I2C Address

Table 3. Default I2C Addresses

<table>
<thead>
<tr>
<th>Sensor Type</th>
<th>Ref</th>
<th>Part Number</th>
<th>Slave Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temp sensor</td>
<td>U6</td>
<td>TMP008</td>
<td>0x41</td>
</tr>
<tr>
<td>Accelerometer</td>
<td>U10</td>
<td>BMA222</td>
<td>0x18</td>
</tr>
</tbody>
</table>

2.4.3 Power Connections

The board can be powered by using the on-board micro USB connector. An on-board LDO provides 3.3 V for the CC3200 and the rest of the board to operate. This supply can be isolated from the LDO using the jumpers on the board.

Table 4. Jumper Settings

<table>
<thead>
<tr>
<th>Reference</th>
<th>Usage</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>J12</td>
<td>Current measurement</td>
<td>Measures the current flowing into the CC3200 device.</td>
</tr>
<tr>
<td>J13</td>
<td>Board power</td>
<td>Short: Supply the board power from the on-board LDO.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open: Supply the board power from the J20 (battery connector)</td>
</tr>
<tr>
<td>J19</td>
<td>5 V power</td>
<td>5 V output from the USB VBUS (has a diode drop of up to 0.4 V)</td>
</tr>
<tr>
<td>J20</td>
<td>3.3 V power input</td>
<td>Can be used to power the board from an external 2XAA battery pack. It has in-built reverse voltage protection to prevent the battery from being plugged in the reverse manner.</td>
</tr>
</tbody>
</table>
2.4.4 UART Signals

The board supports a USB-based virtual COM port, which is used on the FTDI device FT2232D. There are two ports on the FT2232: the first port is dedicated for the emulation (JTAG/SWD) and the second port is used for the virtual COM port. The UART can also be routed to the 20-pin connector and the selection is performed using jumpers on the board.

![Figure 6. UART Signals](image.png)

### Table 5. UART Signals

<table>
<thead>
<tr>
<th>Reference</th>
<th>Usage</th>
<th>Comments</th>
</tr>
</thead>
</table>
| J6, J7    | UART for Flash programming | Short 1-2: Route the signals to the 20-pin connector.  
|           |                   | Short 2-3: Route the signals to the FTDI for Flash programming. |
2.4.5 Sense on Power

The CC3200 can be set to operate in three different modes based on the state of the Sense on Power (SOP) lines. These are pins 21, 34, 35 on the CC3200 device. The state of the device is described in Table 6.

Table 6. SOP Lines

<table>
<thead>
<tr>
<th>Usage</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOP[2:0]</td>
<td>100 = Flash programming</td>
</tr>
<tr>
<td></td>
<td>000 = Functional mode + 4 Wire JTAG</td>
</tr>
<tr>
<td></td>
<td>001 = Functional mode + 2 Wire JTAG</td>
</tr>
</tbody>
</table>

Note: SOP[2:0] corresponds to J15, J16, and J17, in the LaunchPad schematic design.
### Table 7. Miscellaneous Settings

<table>
<thead>
<tr>
<th>Reference</th>
<th>Usage</th>
<th>Comments</th>
</tr>
</thead>
</table>
| J4        | Accelerometer Interrupt | Short = Route the Accelerometer sensor interrupt to the GPIO_13  
Open = Isolates the Interrupt to the GPIO_13                                    |
| J5        | Debug Header | To observe the Network Processor (NWP), MAC Logs.                        |
| J14       | SOP2 Isolation | Isolate SOP2 (GPIO_25) from the 20 pin connector                       |
## 2.4.7 Push Buttons and LEDs

### Table 8. Push Buttons

<table>
<thead>
<tr>
<th>Reference</th>
<th>Usage</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW1</td>
<td>RESET</td>
<td>This is used to RESET the CC3200 device. This signal is also output on the 20-pin connector to RESET any external BoosterPack which may be stacked.</td>
</tr>
<tr>
<td>SW2</td>
<td>GPIO_22</td>
<td>When pushed, the GPIO_22 will be pulled to VCC.</td>
</tr>
<tr>
<td>SW3</td>
<td>GPIO_13</td>
<td>When pushed, the GPIO_13 will be pulled to VCC.</td>
</tr>
</tbody>
</table>
### Table 9. LEDs

<table>
<thead>
<tr>
<th>Reference</th>
<th>Color</th>
<th>Usage</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1</td>
<td>Yellow</td>
<td>nRESET</td>
<td>This LED is used to indicate the state of nRESET pin. If this LED is glowing, the device is functional.</td>
</tr>
<tr>
<td>D2</td>
<td>Green</td>
<td>Debug</td>
<td>This LED glows whenever the debugging is enabled over the JTAG</td>
</tr>
<tr>
<td>D4</td>
<td>RED</td>
<td>Power</td>
<td>Indicates when the 3.3 V power is supplied to the board.</td>
</tr>
<tr>
<td>D5</td>
<td>GREEN</td>
<td>GPIO_11 (1)</td>
<td>Glows when the GPIO is logic-1</td>
</tr>
<tr>
<td>D6</td>
<td>YELLOW</td>
<td>GPIO_10 (1)</td>
<td>Glows when the GPIO is logic-1</td>
</tr>
<tr>
<td>D7</td>
<td>RED</td>
<td>GPIO_09</td>
<td>Glows when the GPIO is logic-1</td>
</tr>
</tbody>
</table>

(1) GPIO_10 and GPIO_11 are used as I2C also. So whenever the pull-ups are enabled, the LEDs would glow.
2.4.8 2x20 Pin Connector Assignment

The signal assignment on the 2x20 pin connector is shown in Figure 8. The P1-Pn naming convention is used for 2x20 pin connectors only.

![Figure 8. 2x20 Pin Connector](image)

The signal mappings are as indicated in above table shown in Figure 8. All the signals are referred by the pin number in the SDK and Figure 8 shows the default mappings. Note that some of the pins are repeated across the connector. For instance, pin 62 is available on P1 and P4, but only P1 is connected by default. The signal on P4 is marked with a "(star) to signify that it is not connected by default. It can be routed to the pin by using a 0 Ω resistor in the path. For the exact resistor placement, see the schematics and placement diagram.

2.5 Power

The LaunchPad is designed such that it can be powered by the USB connection or by external 2xAA/2xAAA batteries.
2.5.1 USB Power

The LaunchPad is designed to work from the USB provided power supply. The LaunchPad will enumerate as a bus-powered device on the computer. When the board is powered from the USB connector, make sure that the jumpers are placed on the following headers, as shown in Figure 9.

J12 (shorted)
J13 (shorted)

Figure 9. Powering From USB
2.5.2 Battery Power (2 x 1.5 V)

The LaunchPad can also be powered from an external battery pack by feeding the voltage on the J20 header. This input features reverse voltage protection to ensure that the board is not damaged due to an accidental reverse voltage. The following care should be taken while using the board with a battery

1. Remove the USB cable.
2. Plug-in the battery pack on J20 with correct polarity (see Figure 10).

![Figure 10. Battery Power](image)

2.5.3 BoosterPack Power Supply

The CC3200 LaunchPad can be powered by a stacked booster-pack which can provide a 3.3 V power on P1.1. During this mode, ensure that the J13 is removed so that the on-board LDO is not overloaded.

2.6 Measure CC3200 Current Draw

To measure the current draw of the CC3200, use the 3V3 jumper on the jumper isolation block. (J12). The current measured in this mode includes only the CC3200 current and no external blocks. However, if a GPIO of the CC3200 is driving a high current load like LED, then that is also included in this measurement.
2.6.1 Measuring Low Power (< 1mA)

Follow these steps to measure ultra-low power:

1. Remove the 3V3 jumper (J12); attach an ammeter across this jumper.
2. Make sure that the CC3200 is not driving any high current loads directly like an LED as this can cause large current drawn.
3. Begin target execution and set the device to low-power modes (LPDS or Hibernate).
4. Measure the current. (Keep in mind that if the current levels are fluctuating, it may be difficult to get a stable measurement. It is easier to measure quiescent states.)

Figure 11. Measuring Low Power
2.6.2 Measuring Active Power

1. Remove the 3V3 jumper (J12).
2. Solder a 0.1 Ω resistor on the board at R62. Or, attach a jumper wire between J12 so that it can be used with a current probe.
3. Measure the voltage across the R62 using an oscilloscope with a differential probe. (For the current probe, coil the wire around the sensor multiple times for good sensitivity).
4. An ammeter can also be used for this measurement, but the results may be erroneous due to the switching nature of the current.
2.7 RF Connections

2.7.1 Radiated Testing (AP connection)

By default the board ships with the RF signals routed to the on-board chip antenna. An on-board u.fl (Murata) connector provides a means to perform the testing in the lab using a compatible cable.

Figure 13. Radiated Testing Using Chip Antenna

Figure 14. Board Set for Conducted Testing
2.8 Design Files

2.8.1 Hardware

All design files include schematics, layout, Bill of Materials (BOM), Gerber files and documentation, which are made available for download from the following URL: http://www.ti.com/tool/cc3200-launchxl-rd.

2.8.2 Revision History

Table 10. Change Log

<table>
<thead>
<tr>
<th>PCB Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rev 3.0B</td>
<td>• First baseline revision</td>
</tr>
</tbody>
</table>
| Rev 3.1      | The main changes pertain to the bill of materials (BOM) and the layout:  
|              | • Replaced the caps C23, C24 with ceramic ones to minimize leakage current  
|              | • R62 is made to DNP by default so that the jumper is used to measure the hibernate current  
|              | • Misc silk screen changes in order to clearly annotate components on the board. |
| Rev 3.2      | • Layout changes for the DC-DC section in order to improve the mask margin  
|              | • Updated the silk screen to reflect the final markings. |
| Rev 4.1      | • Added pull-up/pull-downs for the serial flash. (Reduces hibernate current to around 17 uA)  
|              | • Moved the nRESET pull from VCC_BRD to VBAT_CC (Ensures always pulled high).  
|              | • Added pull-up on UART_TX going to the FTDI to prevent false start bits.  
|              | • Added pull-up resistor for Acccelerometer address to avoid conflict with Audio Booster pack  
|              | • Added 100K pull-up on RESET_OUT net for any BP without RESET pulls.  
|              | • Changed R61 to 2.7K, R57-> 270 Ohms (To solve false entering to bootloader mode)  
|              | • Miscellaneous silk changes |

2.8.3 Software

All design files including firmware patches, software example projects, and documentation are made available from the SimpleLink Wi-Fi Platform page.

The Software Development Kit (SDK) to use with the CC3200 LaunchPad can be obtained from http://www.ti.com/tool/cc3200sdk.
3 Software Examples

3.1 Development Environment Requirements

To use any of the following software examples with the LaunchPad, you must have an integrated development environment (IDE) that supports the CC3200 device.

For more details on where to download the latest IDE, see Section 4.3.

The CC3200 Programmer's guide (SWRU369) has detailed information on software environment setup, and examples. Please refer to this document for further details on the software sample examples.

3.1.1 CCS

CCS 6.0 or higher is required. When CCS has been launched, and a workspace directory chosen, use Project → Import Existing CCS Eclipse Project. Direct it to the desired demo’s project directory containing main.c.

3.1.2 IAR

IAR 6.70 or higher is required. To open the demo in IAR, simply choose File → Open → Workspace…, and direct it to the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is contained within this file.

The subdirectory also has an *.ewp project file; this file can be opened into an existing workspace, using Project → Add-Existing-Project….

4 Additional Resources

4.1 LaunchPad Wiki

Most updated information would be available on the CC3200 Wiki page.

4.2 Information on the CC3200

For more information on CC3200 visit the product page (http://www.ti.com/product/cc3200) (datasheet and key documents like the technical reference manual (TRM)) and Wiki (http://www.ti.com/simplelinkwifi-wiki) (Organize information for Getting started, Hardware details, Software details including porting information, Test/Certification and Support and Community).

4.3 Download CCS, IAR

Although the files can be viewed with any text editor, more can be done with the projects if they’re opened with a development environment like Code Composer Studio (CCS), IAR, or Energia.

CCS and IAR are each available in a full version, or a free, code-size-limited version. The full out-of-box demo cannot be built with the free version of CCS or IAR (IAR Kickstart) due to the code size limit. To bypass this limitation, a code-size-limited CCS version is provided, that has most functionality integrated into a library. The code that is built into the library is able to be viewed by the user, but it cannot be edited. For full functionality download the full version of either CCS or IAR.

4.4 The CC3200 Code Examples

The user’s guide for each example can be found within the Software Development Kit (SDK), or on the SimpleLink Wiki.

4.5 CC3200 Application Notes

There are many application notes with practical design examples and topics located at the SimpleLink(TM) Wi-Fi(R) main wiki page, and the main landing page.
4.6 The Community

4.6.1 TI E2E Community
Search the forums at e2e.ti.com. If you cannot find your answer, post your question to the community!

5 Known Limitations

5.1 Hardware Limitations

5.1.1 Floating IO (All Revisions)
All the GPIO outputs from the CC3200 device would float while the device enters hibernate state. This can cause glitches on the lines if they are not pulled externally.

5.1.2 Board Modification for LPDS Mode
There must be a 100K pull-down resistor on the pin19 (JTAG_TCK) for the device to reliably enter the LPDS mode. This is not present on the boards.

5.1.3 Floating S-Flash Lines (Rev 3.2 and Earlier)
The SPI lines routed from the CC3200 to the on-board serial flash are not pulled up or down using resistors on the board. When the device enters Hibernate state, these pins can be floating and high currents can be drawn by the serial flash.
Revision History

Changes from A Revision (August 2014) to B Revision

- Added Board Modification for LPDS Mode section................................................................. 23

Revision History

Changes from Original (June 2014) to A Revision

- Added note. .................................................................................................................. 4
- Added Rev 4.1 value to table............................................................................................. 21
- Removed Floating S Flash Lines section............................................................................. 23
- Added Floating S-Flash Lines (Rev 3.2 and Earlier) section.............................................. 23

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

STANDARD TERMS AND CONDITIONS FOR EVALUATION MODULES

1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, or documentation (collectively, an "EVM" or "EVMs") to the User ("User") in accordance with the terms and conditions set forth herein. Acceptance of the EVM is expressly subject to the following terms and conditions.

1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For clarification, any software or software tools provided with the EVM ("Software") shall not be subject to the terms and conditions set forth herein but rather shall be subject to the applicable terms and conditions that accompany such Software.

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned, or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production system.

2 Limited Warranty and Related Remedies/Disclaimers:

2.1 These terms and conditions do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License Agreement.

2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM to User. Notwithstanding the foregoing, TI shall not be liable for any defects that are caused by neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have been altered or modified in any way by an entity other than TI. Moreover, TI shall not be liable for any defects that result from User's design, specifications or instructions for such EVMs. Testing and other quality control techniques are used to the extent TI deems necessary or as mandated by government requirements. TI does not test all parameters of each EVM.

2.3 If any EVM fails to conform to the warranty set forth above, TI's sole liability shall be at its option to repair or replace such EVM, or credit User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day warranty period.

3 Regulatory Notices:

3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
This kit is designed to allow product developers to evaluate electronic components, circuitry, or software associated with the kit to determine whether to incorporate such items in a finished product and software developers to write software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference. Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
STANDARD TERMS AND CONDITIONS FOR EVALUATION MODULES (continued)

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

FCC Interference Statement for Class A EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada

3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210

Concerning EVMs Including Radio Transmitters:

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Concernant les EVMs avec appareils radio:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.

Concernant les EVMs avec antennes détaçables
STANDARD TERMS AND CONDITIONS FOR EVALUATION MODULES (continued)

Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et d'un gain maximal (ou inférieur) approuvé par l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le manuel d'usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur.

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

日本国内に輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan are NOT certified by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, User is required by Radio Law of Japan to follow the instructions below with respect to EVMs:
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for Enforcement of Radio Law of Japan,
2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to EVMs, or
3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】

本開発キットは技術基準適合証明を受けておりません。

本製品のご使用に際しては、電波法遵守のため、以下のいずれかの措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備にてご使用いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。

上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。

日本テキサス・インスツルメンツ株式会社
東京都新宿区西新宿6丁目24番1号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

4 EVM Use Restrictions and Warnings:
4.1 EVMs ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information related to, for example, temperatures and voltages.
4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI's recommended specifications and environmental considerations stated in the user guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or property damage. If there are questions concerning performance ratings and specifications, User should contact a TI field representative prior to connecting interface electronics including input power and intended loads. Any loads applied outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative. During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit components may have elevated case temperatures. These components include but are not limited to linear regulators, switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the information in the associated documentation. When working with the EVM, please be aware that the EVM may become very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the dangers and application risks associated with handling electrical mechanical components, systems, and subsystems. User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees, affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal, state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local requirements.

5. **Accuracy of Information:** To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as accurate, complete, reliable, current, or error-free.

6. **Disclaimers:**

6.1 EXCEPT AS SET FORTH ABOVE, EVMs AND ANY WRITTEN DESIGN MATERIALS PROVIDED WITH THE EVM (AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED “AS IS” AND “WITH ALL FAULTS.” TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS AND CONDITIONS SHALL BE CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSES OR ANY OTHER THIRD PARTY, TO USE THE EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR IMPROVEMENT MADE, CONCEIVED OR ACQUIRED PRIOR TO OR AFTER DELIVERY OF THE EVM.

7. **USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS,** USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES, EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS AND CONDITIONS. THIS OBLIGATION SHALL APPLY WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

8. **Limitations on Damages and Liability:**
STANDARD TERMS AND CONDITIONS FOR EVALUATION MODULES (continued)

8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE TERMS AND CONDITIONS OR THE USE OF THE EVMS PROVIDED HEREUNDER, REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING, OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI MORE THAN ONE YEAR AFTER THE RELATED CAUSE OF ACTION HAS OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI’S AGGREGATE LIABILITY FROM ANY WARRANTY OR OTHER OBLIGATION ARISING OUT OF OR IN CONNECTION WITH THESE TERMS AND CONDITIONS, OR ANY USE OF ANY TI EVM PROVIDED HEREUNDER, EXCEED THE TOTAL AMOUNT PAID TO TI FOR THE PARTICULAR UNITS SOLD UNDER THESE TERMS AND CONDITIONS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM AGAINST THE PARTICULAR UNITS SOLD TO USER UNDER THESE TERMS AND CONDITIONS SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy: Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s) will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the component(s), excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas, without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas. Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief in any United States or foreign court.
IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All semiconductor products (also referred to herein as “components”) are sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI's terms and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily performed.

TI assumes no liability for applications assistance or the design of Buyers' products. Buyers are responsible for their products and applications using TI components. To minimize the risks associated with Buyers' products and applications, Buyers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of significant portions of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional restrictions.

Resale of TI components or services with statements different from or beyond the parameters stated by TI for that component or service voids all express and any implied warranties for the associated TI component or service and is an unfair and deceptive business practice. TI is not responsible or liable for any such statements.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support that may be provided by TI. Buyer represents and agrees that it has the all the necessary expertise to create and implement safeguards which anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause harm and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and requirements. Nonetheless, such components are subject to these terms.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties have executed a special agreement specifically governing such use.

Only those TI components which TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components which have not been so designated is solely at the Buyer’s risk, and that Buyer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

Products

- Audio: [www.ti.com/audio](http://www.ti.com/audio)
- Amplifiers: [amplifier.ti.com](http://amplifier.ti.com)
- Data Converters: [dataconverter.ti.com](http://dataconverter.ti.com)
- DLP® Products: [www.dlp.com](http://www.dlp.com)
- DSP: [dsp.ti.com](http://dsp.ti.com)
- Clocks and Timers: [www.ti.com/clocks](http://www.ti.com/clocks)
- Interface: [interface.ti.com](http://interface.ti.com)
- Logic: [logic.ti.com](http://logic.ti.com)
- Power Mgmt: [power.ti.com](http://power.ti.com)
- Microcontrollers: [microcontroller.ti.com](http://microcontroller.ti.com)
- RFID: [www.ti-rfid.com](http://www.ti-rfid.com)
- OMAP Applications Processors: [www.ti.com/omap](http://www.ti.com/omap)
- Wireless Connectivity: [www.ti.com/wirelessconnectivity](http://www.ti.com/wirelessconnectivity)

Applications

- Automotive and Transportation: [www.ti.com/automotive](http://www.ti.com/automotive)
- Communications and Telecom: [www.ti.com/communications](http://www.ti.com/communications)
- Energy and Lighting: [www.ti.com/energy](http://www.ti.com/energy)
- Industrial: [www.ti.com/industrial](http://www.ti.com/industrial)
- Medical: [www.ti.com/medical](http://www.ti.com/medical)
- Video and Imaging: [www.ti.com/video](http://www.ti.com/video)

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2015, Texas Instruments Incorporated